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Safety Precautions 
 

For your own safety and to protect the QBraille XL from accidental damage, 

please read and abide by the following safety precautions. 

 

1. The input voltage of the AC adapter is 100V - 240V, and the output is 

DC 5V / 2A. 

2. When you use the QBraille XL with the battery for the first time, the 

battery status may not be displayed accurately. To ensure the accuracy 

of the battery gauge, power on the QBraille XL and charge the unit via 

the AC adapter for more than four and a half hours or leave the QBraille 

XL connected to the USB cable for more than ten and a half hours.  

 

3. Your QBraille XL needs to be handled with care. The QBraille XL is a 

very delicate machine. Make sure to handle the unit in a proper manner. 

Also, the QBraille XL is very sensitive to dust. Make sure to keep the 

QBraille XL away from dusty environments. 

 

4. The Braille cells are particularly sensitive, intricate parts. If any of the 

Braille cells are not working properly due to the presence of dust or any 

other reason, please contact our repair center, or the dealer from whom 

you purchased the QBraille XL for support. 

 

5. If you let your QBraille XL remain for a long time in a closed, high 

temperature environment such as inside a car on a hot summer day, the 

battery attached to the QBraille may malfunction or catch fire. Please 

keep your QBraille XL away from such environments. 

 

6. Do not disassemble the QBraille XL yourself. Do not have anyone else 

who is not authorized by HIMS take apart the QBraille XL. If an 

unqualified person disassembles the unit, serious damage may occur to 

the QBraille XL. If an unauthorized person disassembles the QBraille 

XL, the warranty is voided, and the unit will be excluded from any free 

maintenance. If any liquid or external force damages the unit, it may also 



 

 

be excluded from free maintenance, even if the damage occurs during 

the warranty period. 

 

7. We thank you for using the QBraille XL, and we value any comments or 

suggestions you have for our product. If you have any complaints or 

suggestions, please place your comments on our website. We will 

improve our product based on your comments and suggestions.  

 

8. This equipment has been tested and found to comply with the limits for a 

Class B digital device, pursuant to part 15 of the FCC Rules. These 

limits are designed to provide reasonable protection against harmful 

interference in a residential installation. 

 

Operation is subject to the following two conditions. 

1) This device may not cause harmful interference, and 

2) This device must accept any interference received, including 

interference that may cause undesired operation. 

 

This equipment can generate, use and radiate radio frequency energy 

and, if not installed and used in accordance with the instructions, may 

cause harmful interference to radio communications. However, there is 

no guarantee that interference will not occur in a particular installation.  

 

If this equipment does cause harmful interference to radio or television 

reception, which can be determined by turning the equipment off and on, 

the user is encouraged to try to correct the interference by one or more of 

the following measures: 

- Reorient or relocate the receiving antenna. 

- Increase the separation between the equipment and receiver. 

- Connect the equipment into an outlet on a circuit different from that to 

which the receiver is connected. 

- Consult the dealer or an experienced radio/TV technician for help. 

 



 

 

 

IMPORTANT NOTE: 

FCC RF Radiation Exposure Statement: 

This equipment complies with FCC RF radiation exposure limits set forth 

for an uncontrolled environment. This equipment should be installed and 

operated with a minimum distance of 20 cm between the radiator and 

your body. This transmitter must not be co-located or operating in 

conjunction with any other antenna or transmitter. 

 

 

Notice 
 

◼ This user manual and products are protected by copyright law 

◼ Microsoft Windows, and the Windows Logo are registered trademarks or 

trademarks of Microsoft Corporation United States other countries. 
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1. Getting Started 
1.1 What is the QBraille XL?  

The QBraille XL is a 40-cell Braille display developed and manufactured by 

SELVAS Healthcare for use by the blind and visually impaired. Its unique 

Hybrid keyboard allows the convenience of contracted Braille entry while 

offering intuitive standard QWERTY keyboard command and operation with 

computers, smartphones and tablets. The QBraille XL can be used to do 

the following: 

1) Use the QBraille XL as a Braille display/terminal for your Windows, Mac, 

IOS, or Android screen reader. The Perkins-style keyboard, scroll and 

navigation keys as well as standard QWERTY modifiers and function 

keys, provide the convenience of Braille input combined with the intuitive 

functionality of a computer keyboard. 



 

 

2) Use the built-in “Notepad” to create and edit Braille and text documents, 

or read BRF, RTF, DOC or DOCX and PDF files on the go. 

3) Read and Navigate text-based DAISY class materials as well as your 

favorite novels. 

4) Utilize several built-in utilities including Schedule Manager, Calculator, 

alarm/clock, stopwatch, and count-down timer. 

 

1.2 Package 

Your QBraille XL packing box should contain the following items: 
1) QBraille XL  
2) Power Adapter 
3) USB C Cable 
4) Carrying case 
5) Braille Quick Reference Guide 

 

1.3 Hardware Specifications  

1) Operating System: Windows CE 6.0 

2) RAM: 256 MB 

3) CPU: Samsung S5PV210 

4) Battery: Lithium polymer rechargeable battery 

5) Running Time: About 20 hours 

6) Keyboard: 9-key Perkins-style Braille keyboard, QWERTY modifiers 

and function keys in their standard positions, 4 Scroll buttons, 40 cursor 

routing keys 

7) Additional Buttons: Power button, hard reset button 

8) Braille display: 40 refreshable Braille cells 

9) Bluetooth: Ver.2.1+EDR 

10) Interface: 1 USB-C, 1 SD slot 

11) Sound: Mono speaker 

12) Size: 31cm x 11.9cm x 1.8cm 

 



 

 

1.4 Physical Orientation 

 

To get the most from your QBraille XL, it is important to become oriented to 

the buttons on your QBraille XL as well as learning their functions. This 

section explains the physical configuration of the QBraille XL. Place the 

QBraille XL on a desk or table top with the Braille display nearest you. Its 

shape resembles a long, thin rectangular box. This section of the manual 

describes each side of the QBraille XL and the basic function(s) of each 

button.  

 

1.4.1 Top panel 

 

The top face of the unit contains the keyboard and Braille display. Along 

the front edge of the top panel are 40 refreshable Braille cells. Just above 

the Braille display. There are 40 small, oval-shaped buttons corresponding 

to each of the 40 Braille cells. These buttons are called cursor routing keys. 

Each 5th cursor router is marked with a dot for easier orientation. When you 

are editing documents, you can use these keys to route your cursor to the 

character of the corresponding Braille cell. When using QBraille with screen 

readers such as iOS and BrailleBack, cursor routers can be used to select 

the item under the cursor. 

 

On each side of the Braille display are two capsule shaped keys. These are 

the "UP" and "DOWN" scroll keys. The scroll keys are used to scroll the 

Braille display through menus, fields, lists or text. You can use the scroll 

keys to scroll by display length or line.  

 

The largest portion of the top face is taken up with the unique Hybrid 

keyboard, consisting of a 9-key Perkins Braille keyboard along with several 

standard QWERTY modifier and function keys, and a couple of special 

keys specific to QBraille. 

 



 

 

In the center of the keyboard is a traditional Braille keyboard made up of 

Braille dots 1-6 as well as Space, Backspace and Enter. On the same row 

as the spacebar are several modifier keys, located in similar positions as 

they would be on a standard QWERTY keyboard. From left to right are 

Control, Function, Windows, Alt, Space, Alt, Applications, and Control. 

When using a Mac or iOS device, the bottom row functions, from left to 

right, as, Function, control, option, Command, Space, command, Option, 

and Control. *Note: You can change to a traditional Apple keyboard layout 

in the options Menu. 

 

Above the Braille Keyboard, on the top row, you will find the Escape key in 

the top left corner, and the standard F1 to F12 keys in groups of 4 to the 

right, with F4, F8 and F12 tactilely marked. On the far right is a group of 6 

keys arranged in 2 vertical rows of 3. These keys are equivalent to the 

standard 6 pack on a QWERTY keyboard. The left column, from top to 

bottom, contains Insert, Home and End. The right column contains Delete, 

Page Up, and Page down. Below these keys are the Up, Down, Left and 

Right arrow keys.  

 

*Note: when using a Mac, the arrow keys are often used in combinations 

such as for turning Quick Nav on and off. You may also use the following 

Braille keyboard keystrokes to emulate these combinations: 

• Space-Dots-3-6 Left arrow and Right arrow 

• Space-Dots-1-4: Up arrow and Down arrow 

• Space-Dots-1-6: Up arrow and Right Arrow. 

• Space-Dots-3-4: Up arrow and Left Arrow 

 

On the far left, below Escape and F1, is another set of 5 keys, arranged in 

2 columns. Below F1, to the left of the Backspace key, from top to bottom, 

are located Tab, Capslock and Shift. Below Escape are 2 additional keys 

specific to QBraille.  

 



 

 

Just below Escape is the Pairing key. This key is used in conjunction with 

other keys to perform several functions related to device connectivity, 

including switching to specific connections, getting information about the 

current connection, and accessing the Pairing List. 

 

Below the Pairing Key is the Mode key. The Mode key allows you to switch 

Hybrid Mode on and off and has additional functions when used in 

conjunction with other keys. Please see the Connectivity section for 

additional information on the functions of the Pairing and Mode keys. 

 

The LED lights are located above the arrows on the right side of the top 

face. The left LED light shows Bluetooth status; when Bluetooth is 

activated, this LED light turns blue. The right LED indicates the status of 

the power; when you are charging the unit, the LED turns red. When the 

QBraille XL is powered on, the LED turns yellow. These LED lights help a 

sighted person easily determine the status of the unit when working with 

students.  

 

1.4.2 The Right Panel 

 

The right panel contains 2 items. Near the rear of the unit is the SD card 

slot. The QBraille XL can accommodate high capacity SD cards up to 

32GB. 

Nearer the front of the unit is the USB C port. Use this port to charge the 

QBraille XL or to connect to a computer as a USB keyboard/Braille display. 

 

1.4.3 Left Panel  

 

The left panel contains only one button, a small, rectangular button marked 

with a small dot used to turn the QBraille XL on/off.  

Press the power button for about 1 second to power the unit on/off.  



 

 

When the unit is powered on, again, hold the Power button for about 1 

second to power the unit off. If the unit is booting from a complete 

shutdown, press and hold the power button for a couple of seconds, until 

you hear a short beep and feel a vibration. “HIMS” is displayed in Braille for 

several seconds. Just before booting is complete “HIMS QBraille XL” is 

shown briefly on the Braille display, followed by the power on sound, and 

you are placed in the Main Menu. Generally, the QBraille’s power button 

brings it in and out of a kind of Sleep Mode, for instant availability and to 

keep the clock running. To completely power off the QBraille, press and 

hold the power button for at least 3 seconds. 

 

1.4.4 Rear Panel 

 

The rear panel of the QBraille XL contains 1 very small button. Near the 

right end of the rear panel is a small pin hole containing the “Hard reset” 

button. The “Hard reset” button is used when the unit does not respond as 

you expect, or when the battery is completely depleted and connecting the 

AC adapter doesn’t reboot the unit. You can use a toothpick or the end of a 

paperclip to press the “Hard reset” button. Be careful when pressing the 

“Hard reset” button as, if you are not careful, pressing too hard or using an 

end too small may damage the device. 

2. Basic Functions  
 

2.1 Power on/off 

 

The first time you power the unit on, and subsequently, when the unit’s 

battery dies, or the unit has been completely shut down, you must press 

and hold the power button for about 3 seconds to boot the unit. You will feel 

a vibration, and hear a short beep, and see startup messages on the braille 

display. When booting is complete, the power on music sounds, and you 

are placed in the QBraille’s main menu, and “Notepad” is displayed. 

 



 

 

Once booted, press the power button on the left panel for about 1 second 

to power the unit on/off.  

 

2.2 How to navigate 

Use the following keystrokes to navigate menus, lists, and programs on the 

QBraille XL: 

 

1. Move to the next item in a menu or list:  

    Down arrow or Space-4 

2. Move to the previous item in a menu or list: 

    Up arrow or Space-1 

3. Move to the first item in a menu or list:  

    Home or Space-1-3 

4. Move to the last item in a menu or list:  

   End or Space-4-6 

5. Move to the next 40 items:  

    Page Down or Space-3-4-5 

6. Move to the previous 40 items:  

    Page Up or Space-1-2-6 

7. Execute program:  

    Enter or cursor routing key twice 

8. Enter sub folder:  

    Enter or cursor routing key twice 

9. Cancel: Esc key or Space-E 

2.3 Modifier and Function keys 

The QBraille XL contains a unique Hybrid keyboard that combines natural 

contracted Braille text entry with standard QWERTY operation of your 

computer, phone or tablet. Modifiers like Control, FN, Win, Alt, and 

Applications are located in standard positions on the same row as the 

Space key. The top row of the keyboard contains Escape and 12 function 

keys, just as a standard QWERTY keyboard. Tab, Capslock, Shift, Insert 



 

 

and Delete, Home and End, Page Up and Page Down and the 4 arrow 

keys are also present in similar positions as they would be on a standard 

QWERTY keyboard.  

Thus, while you can use your natural grade of braille, your command of 

Windows and other operating systems does not require memorization of 

strange combinations of Braille and function keys unique to the screen 

reader you are running. For example, to close a Windows application, 

press “Alt-F4”. To minimize apps and go to the desktop, press Windows-M, 

just as you would do on a standard QWERTY keyboard.  

When entering text in Braille, if using grade 1 or grade 2, text is translated 

internally and sent as whole words when Space or Enter is pressed. 

*Note: QBraille can be used with both windows and Apple devices, as well 

as Android phones and tablets. You may wish to change the layout of the 

keyboard depending on which operating system you are using. You may 

switch between a traditional Microsoft and Apple keyboard layout in the 

Options menu.  

⚫ Note: You cannot multi-task on the QBraille XL, thus there is no hot key 

for bringing up the main menu, as you must exit the current program 

and return to the main menu before opening another application.  

 

2.4 Using Menus 

 

The main menu on the QBraille XL consists of the following 6 items: 

1. Notepad 

2. Connectivity 

3. DAISY reader 

4. Applications 

5. Options 

6. Information 



 

 

 

You can navigate the main menu, or any menu on the unit, using the 

navigation commands listed in the previous section. You can also press the 

menu’s shortcut key, usually the first letter of the menu name, to quickly 

jump to and execute that menu item. Often menu items can also be 

executed instantly with a hotkey, enabling you to perform the desired action 

without accessing the menus. 

 

When viewing menu items, several things are displayed including the item 

name, its shortcut key, a hot key if one is available, and whether the item 

has a sub menu or opens a dialog. 

 

1) Shortcut keys:  

Shortcut keys are displayed in parentheses following the menu names for 

example, Open (o). If you press the shortcut key, you can execute the 

menu or item directly from anywhere in the menu.  

 

2) Sub menus:  

When a menu contains a sub menu, the word "Pulldown" is displayed after 

the item to indicate that pressing "Enter" will "pull down" another menu. 

 

3) Dialogs:  

When the menu item opens a dialog, the word "Dialog" is displayed after 

the item to indicate that pressing "Enter” on this item will bring up a dialog. 

 

4) Hot keys: 

Hotkeys generally consist of a modifier such as "Enter," "Space," or 

"Backspace", pressed simultaneously with a letter or dot combination. 

These are displayed following the shortcut keys. 

 

 For example, if you are in the Notepad, and press "Space-m (dots 1-3-4)" 

or "F2," then press "Enter" on "File," you see "New (n) pull down Ctrl-n". 

The word "New" is the menu option. YOU would press the letter "n (dots 1-

3-4-5)" to jump to "New" from within the "File" menu. Press "Ctrl-n" to 



 

 

access the "New" document command from anywhere in Notepad. The “n” 

is the shortcut key and "Ctrl-n" is the hotkey. It is important to note that 

some hotkey commands are global, thus will work from anywhere on the 

unit, and some are program specific. 

 

⚫ Note: if you are in a sub menu or dialog box, and the QBraille XL is 

powered off, when the unit is powered back on, the sub menu or dialog 

is closed, and you are returned to the location at which you entered the 

menus. 

 

2.5 Charging and using battery 

Though the QBraille XL alerts you when the battery is low, it is important to 

keep track of the battery status so as not to lose unsaved data or 

unexpectedly disconnect a Bluetooth Braille display connection. 

To check the battery power status, press "Space-P (dots 1-2-3-4)". The unit 

displays the following 2 items: 

1. Battery power level 

2. Power source (battery or USB power) 

 

The battery power level represents the percentage of the remaining battery 

power. The power source indicates whether the unit is being operated 

using the battery or USB power supply. 

 

To close the battery power status dialog, press the Escape key. 

 

When the battery level falls below 15%, the QBraille displays the message, 

“battery low” and suggests you connect to power. When the battery level 

falls below 5%, the QBraille displays a warning that the unit will 

automatically shut down in 3 minutes time if power is not connected.  

 

⚫ Note: if you are concerned about losing Bluetooth connection settings, 

you may wish to activate the “Auto disconnect Bluetooth at 10%” setting 

in the “Global options”. If this item is set to “On”, the QBraille XL alerts 



 

 

you and disconnects from a Bluetooth device when the battery level 

drops to 10%. 

 

2.6 Reset and Hard reset 

If the QBraille XL does not respond to keystrokes or commands, it may be 

necessary to reset the unit.  

 

You can use a toothpick or the end of a paperclip to press the Reset 

button. Be careful when pressing the Reset button as pressing too hard or 

using an end too small may damage the device.  

 

When you press the Reset button, you will feel a long vibration followed by 

the reboot sound. You may also soft reset the unit by holding the power 

button for 3 seconds to completely power the unit off, then once again to 

start the unit booting again.  

 

If you want to restore settings to factory defaults, you may use the 

“Restore” function in the Options menu described later in this manual. 

Alternatively, you can place your focus on the “Information” item in the main 

menu, and press “Backspace-Space-Enter-f (dots-1-2-4)”.  

 

*Note: if you use either method to restore to factory defaults, if an SD card 

is inserted in to the unit, your settings will be automatically restored on 

reboot from that card. If you truly want to restore to factory defaults, please 

remove the SD card before proceeding. 

 

2.7 Set date and time 

It is important for use with the Schedule Manager and alarm functions, that 

the date and time is set correctly. To set the date and time, follow the 

instructions below: 

 



 

 

1) From the Main menu, press “a (dot-1)” to open the Applications Menu. 

Press “t (dots-2-3-4-5)” to open “Date and Time”. Press “Control-s (dots-2-

3-4)”, or press “alt” to open the Menu and press “enter” on “set”. 

 

2) Type the time as hhmm using normal text editing commands. You may 

also use the following navigation keys to modify the time. 

Up/down arrow: change time 

Left/right arrow: modify hour or minute 

 

3) Press “Enter” or right arrow to move to the Date Edit box.  

 

4) Type month, day and year as mmddyyyy. Ex) 01252018 (25th January 

2018) or you can modify the date using the following commands:  

Up/down arrow: change value 

Left/right arrow: modify month, day, year 

 

5) Press ENTER to save your settings. 

 

2.8 Using the help menu 

You can access context specific help anywhere on the unit by pressing 

“Space-h (dots-1-2-5)”. If you press the “Help” command, it brings up a list 

of hot keys pertaining to the currently open program. 

 

Move among the items using Space-dot 1/space-dot4. You can select an 

item or function by pressing “Enter”. However, if you select a function which 

cannot be performed in your current context, an alert sound is heard, and 

no action is executed.  

 

2.9 Testing the Braille display 

There may be times you wish to exercise your Braille display for 

maintenance, or to check to be sure all pins and keys are functioning 

correctly. 



 

 

 

You can enter Test Mode by pressing Backspace-Space-Enter-T (dots-2-3-

4-5). The QBraille immediately begins raising and lowering each Braille pin 

individually at the rate of 1 per second, starting with dot 1 of cell 1, and 

ending with dot 8 of cell 40. 

 

You can pause and resume the test with Space. When paused, you can 

press the cursor router above each cell to raise all the pins in that cell. You 

can also press any key on the unit, and its function is displayed in Braille. 

When you have finished using Test Mode, press Space-Z (dots-1-3-5-6) to 

close it. 

 

2.10 Global Hot Keys 

 

Use the following hot keys to query information about your QBraille XL from 

most places on the unit.    

 

  1) Check capacity of SD card: Space-S  

      (Not available when in Information, Braille Terminal, or Global Options)  

   2) Check battery status: Space-P  

   3) Check firmware version: Space-V  

   4) Check Bluetooth status: Space-B 

   5) Check Date and Time: Space-T 

   6) Open Options menu: Space-O 

   7) Open onboard Help: Space-H 

 

The above hot keys are not available when you are in Information, Terminal 

for Screen Reader, or the Options menu. Help is not available when in a 

dialog box.  

 



 

 

2.11 Using One-Handed Mode 

For users with the use of only one hand, One-Handed mode can be toggled 

on and off in the options menu. You may also toggle it on and off from the 

main menu by pressing “Backspace-dots-1-2-3”. Please observe the 

following rules when operating in one-Handed mode: 

• navigation keys should be pressed twice: arrow keys, page-Up/Down 

and Home/End. Other modifiers need only be pressed once. 

• If using a Braille/modifier key combination, press the Braille keys first, 

then the modifier. 

• When typing Braille letters, press all the Braille keys followed by 

“Space”.  

 

2.12 Using Mass Storage Mode 

As many modern computers do not include card readers, you may find it 

easier to transfer data to and from your QBraille by connecting it directly to 

your computer. You can see your SD card as a Mass storage device when 

the QBraille is connected to your computer by pressing “Mode-Space” from 

the Main Menu. You can also turn Mass storage Mode on and off from the 

Options menu. 

Please note: When Mass storage Device Mode is activated, you cannot 

connect as a keyboard or Braille display via USB. In addition, the Notepad 

and DAISY Player may not be used as the storage needed for the 

associated files is being hosted by the computer, thus, cannot be accessed 

by the QBraille. 

When you have finished transferring files, press “Mode-Space” once again 

to turn Mass Storage Device Mode off and return to normal operation. 

 



 

 

3. Notepad 
 

3.1 What is the Notepad?  

The Notepad on the QBraille XL can be used to manage, read, create, and 

edit documents without connecting to a PC or cell phone. The Notepad 

supports basic editing functions such as selecting and manipulating text, 

find, replace, mark functions, and inserting date, time, or calculator results. 

 

⚫ Note: You cannot use the Notepad program on the QBraille if an SD 

card is not inserted. If you attempt to open the program without an SD 

card inserted, the message, “SD card does not exist” is displayed and 

the Notepad program is closed. 

 

The "notepad" supports creation and editing of TXT and Braille files. Read 

Only support is also available for RTF, DOC, and DOCX files as well as 

text-based PDF documents.  

 

 

3.2 Execute and Exit 

“Notepad” is the first item in the QBraille XL’s main menu. To execute the 

program: navigate to it and press Enter or press a cursor routing key twice. 

Or you can press the hot key, N (dots 1-3-4-5). 

 

To exit “Notepad” press “Space-z (dots 1-3-5-6). If you are editing a 

document, you are asked if you want to save the document. If you want to 

save the document, press “Y (dots 1-3-4-5-6)” or change the answer to 

“Yes” using space or backspace and press “Enter”. If you want to close 

“Notepad” without saving the document, press “N (dots 1-3-4-5)” or change 

the answer to “No” using space or backspace and press “Enter”. 



 

 

3.3 Structure of Notepad 

The “notepad” contains a file browser and a document Window. When you 

first open “Notepad”, you are placed in the file browser listing the Files and 

folders on the SD card inserted in the QBraille XL. For the purposes of 

identification, folder names are surrounded by quotation marks. In the 

file/folder list, you can explore, create, cut, copy, remove and rename 

folders or files. Folders and files are arranged in alphabetical order and are 

displayed as “focused item number/total items”.   

 

Use the following keystrokes to navigate files and folders in the file 

browser: 

1) Move to previous item: up arrow or Space-1 

2) Move to next item: down arrow or Space-4 

3) Move to the first item in the current list: Home or Space-1-3 

4) Move to the last item in the current list: End or Space-4-6. 

5) Enter folder or open file: Enter 

6) Move back a level in the folder structure: Backspace 

 

You can also jump to a file or folder by typing the first letter of the file or 

folder name.  

 

While in the file browser, you can use the menu to perform several file and 

folder management tasks. To open the MENU, press the “Alt” key or space-

m.  

 

Use the following keystrokes to navigate the menu in the browser and/or 

document window: 

1) Move to the previous menu item: up arrow or Space-1 

2) Move to the next menu item: down arrow or Space-4 

3) Move back a level in the menu structure: Esc key.  

4) Enter sub menu/Execute menu item: Enter 

5) Close the menu: Esc key 



 

 

You can also type the shortcut key displayed after the menu item to 

immediately jump to and execute that item. 

Below are the available menu items in the file browser and document 

window: 

 

1) The file browser menu (Accessed by pressing ALT or space-1-3-4): 

Open, Open as Read Only, Recent Document, Copy, Paste, Cut, 

Delete, New Folder, New File, Rename, Find, Select All, Information and 

Exit 

 

2) Available menu items in the document window (Accessed by pressing 

ALT or space-1-3-4): File menu, Edit menu, Mark menu, Tools menu, 

Insert menu 

 

3.4 Opening documents 

3.4.1 Creating a New document  

Move to the folder in which you want to create the document and press 

Ctrl-N (dots 1-3-4-5) or execute the “New file” option under the MENU.  

New document named “noname.brl/noname.txt” is created and your cursor 

is placed on it. Press “ENTER” to open and edit the document.  

 

3.4.2 Open document  

To open a document, press “Ctrl-o (dots1-3-5)”. Navigate to the file you 

want to open in the file list and press “Enter”. If you have not previously 

opened the document, you are placed at the top of the file. If you have 

previously opened the document on the QBraille XL, you are placed at the 

cursor position at which you last closed the document. 

 



 

 

3.4.3 Open recent document  

This function allows you to directly open the last document you read or 

edited on the unit. To open a recent document, press Ctrl-P (dots 1-2-3-4) 

from the file browser. Or open the MENU with “Alt” key or “Space-1-3-4” 

from the File Browser and move to “recent document/” using the “Up/down/ 

arrows and press “enter”. The document you opened most recently is 

loaded automatically. 

 

3.4.4 Open document in “read only” mode  

This function allows you to open a document without concern of accidental 

edits or insertion of data into the document, as this mode only allows you to 

read the document.  

To open a document in Read Only mode, press Ctrl-R (dots1-2-3-5) from 

the file browser. The focused file is opened in “read only” mode and you 

can read the file without concern of undesired editing. 

 

3.5 Save Document 

1. Save 

If you wish to save the currently open document without changing the file 

type or renaming the document, press Ctrl-S (dots 2-3-4) or execute “save” 

under the “File” menu in the document window.  

 

2. Save As 

If you want to save the document under a different file name, press Alt-S 

(dots 2-3-4) or execute “Save As” under the “File” menu in the document 

window. You can change only the file name; you cannot change the file 

type. Type the new file name using computer Braille and press “ENTER”.  

 

⚫ Note: if you save an RTF, PDF, DOC, or DOCX file, it is automatically 

saved as a TXT file as QBraille does not support saving Microsoft Word, 

PDF or RTF files. 



 

 

 

3.6 Document Navigation 

While reading/editing a document, you can navigate using the cursor 

routing keys, the Braille keyboard, and the arrows. 

 

Use the following keystrokes to navigate a document: 

1) Scroll up one display length: up scroll button  

2) Scroll down one display length: down scroll button  

3) Move to previous line: Space-1 or up arrow.  

4) Move to next line: Space-4 or down arrow.  

5) Move to the beginning of the line: Space-1-3 

6) Move to the end of the line: Space-4-6 

7) Move to previous paragraph: Space-2-3 or Ctrl-up arrow.  

8) Move to next paragraph: Space-5-6 or Ctrl-down arrow.  

9) Move to previous page: Page Up or Space-1-2-6. (a page is defined as 

25 lines) 

10) Move to next page: Page Down or Space-3-4-5 (moves down 25 

lines) 

11) Move to the top of the document: Space-1-2-3 or Ctrl-Home 

12) Move to the end of the document: Space-4-5-6 or Ctrl-End 

 

3.7 Editing a Document 

3.7.1 Selecting Text  

The "Start Selection" command allows you to select a certain portion of text 

that you would like to edit. When you use the "Start Selection" command, 

the cursor appears as blinking "dots 7-8" to indicate what text is being 

selected. 

 

To select text in a document, place your cursor on the location at which you 

want to start selecting text. Press "Space-m (dots 1-3-4)" or "Alt" to open 

the menu, and press “E for “Edit”, and press "Enter" on "Start Selection". 



 

 

While editing a document, pressing "Ctrl-b (dots 1-2)" activates this 

command. The end of your selection is the position at which you place your 

cursor after activating the “Start Selection” command. 

 

The "Select All" command selects all text in a document. To activate this 

command, press "Space-m (dots 1-3-4)" or "Alt", and press "Enter" on 

"Edit". Move to "Select All" by pressing "Space-4" repeatedly, and press 

"Enter". While editing a document, press "Ctrl-a (dot 1)" to activate this 

function. 

 

3.7.2 Copy and paste 

To copy the selected text to the clipboard, press "Space-m (dots 1-3-4)" or 

"Alt" to open the menu and move to "Edit" by pressing "Space-4". Press 

"Enter" to open the "Edit" menu. Press "Space-4" to move to "Copy" and 

press "Enter". While editing a document, pressing "Ctrl-c (dots 1-4)" 

activates this command. 

 

To paste selected text from the clipboard, press "Space-m (dots 1-3-4)" or 

"Alt", and press "Enter" on "Edit". Move to "Paste" by pressing "Space-4" 

repeatedly and press "Enter". While editing a document, press "Ctrl-v (dots 

1-2-3-6)" to paste the text from the clipboard to your current cursor location. 

 

3.7.3 Cut 

To cut a selection of text, press "Space-m (dots 1-3-4)" or "Alt", and press 

"Enter" on "Edit". Move to "Cut" by pressing "Space-4" repeatedly, and 

press "Enter". While editing a document, pressing "Ctrl-x (dots 1-3-4-6)" 

activates the "Cut" command. 

 

The difference between "Cut" and "Copy" is that if you execute the "Cut" 

command, the selected text is moved to the clipboard and the selection is 

removed from the document. The "Copy" command simply copies the 

selection to the clipboard, and the selected text remains in the document. 

 



 

 

3.7.4 Delete 

To delete a character, word, line or block, please use the hotkeys below:  

1) Delete previous character: Backspace 

2) Delete current character: Alt-C (dots 1-4) 

3) Delete current word: Alt-W (dots 2-4-5-6) 

4) Delete current line: Alt-L (dots 1-2-3) 

5) Delete block: Space-D (dots 1-4-5) 

 

The “Delete block” command is only available when there is a block of text 

selected. You can also access this command via the “Edit” Menu.  

 

To delete the selected block, press "Space-m (dots 1-3-4)" or "Alt", and 

press "Enter" on "Edit". Move to "delete" by pressing "Space-4" repeatedly, 

and press "Enter".  

 

3.7.5 Undo 

You can undo the last action performed such as “copy”, “cut”, “paste” or 

“delete”. To undo your last command, press "Space-m (dots 1-3-4)" or "Alt", 

and press "Enter" on "Edit". Move to "Undo" by pressing "Space-4" 

repeatedly, and press "Enter". While editing a document, pressing "Ctrl-z 

(dots 1-3-5-6)" activates the "undo" command. 

 

3.7.6 Insert date and time 

You can insert today’s date and current time separately in your document. 

To insert the current date, press "space-m (dots 1-3-4)" or "Alt", and press 

"enter" on "insert". Move to "date" by pressing "space-4" repeatedly and 

press "enter". While editing a document, pressing "Insert-D (dots 1-4-5)" 

activates this command. 

  

To insert the current time, press "space-m (dots 1-3-4)" or "Alt", and press 

"enter" on "insert". Move to "time" by pressing "space-4" repeatedly and 



 

 

press "enter". While editing a document, pressing "Insert-T (dots 2-3-4-5)" 

activates this command. 

 

When you activate one of these functions, today’s date or the current time 

is inserted into your document at your cursor location.  

 

3.7.7 Insert calculation and result 

This function allows you to insert the result of a calculation into your 

document at your cursor location. Press “Insert-R (dots1-2-3-5)”, and the 

result of the current math expression is calculated and inserted into the 

document. Or press "space-m (dots 1-3-4)" or "Alt", and press "enter" on 

"insert". Move to "calculate" by pressing "space-4" repeatedly and press 

"enter". 

 

*Note: If your Braille grade is set to anything other than computer Braille, 

you must use literary Braille to enter math expressions, with the operators 

being preceded by a dot 4. So, to write “3 + 8”, you will enter: number sign, 

then 3, then Space, then dot4, then +, then Space, then 8. 

 

Below are the arithmetic operators which can be used: 

1) Plus: dots 3-4-6 

2) Minus: dots 3-6 

3) Multiply by: dots 1-6 

4) Divided by: dots 3-4 

5) Percent: dots 1-4-6 

6) Power: dots 4-5-7 

7) Decimal point: dots 4-6 

8) Left parenthesis: dots 1-2-3-5-6 

9) Right parenthesis: dots 2-3-4-5-6 

 

3.8 Find and Replace 

 



 

 

3.8.1 Find  

The find function allows you to search for text in a document. Once the text 

is found you are taken to that position in your document. To execute this 

command, press "Space-m (dots 1-3-4)" or "Alt” and move to "tools" by 

pressing "Space-4" and press "Enter". Move to "Find" by pressing "Space-

1" or "Space-4". While editing a document, pressing "Ctrl-f (dots 1-2-4)" 

activates the "Find" command.  

 

When "Find” is executed, the “Find” dialog is displayed. This dialog consists 

of “Text to find” and “Search direction”.  

 

1. Text to find 

The first field in the “Find” dialog is “Text to find”. In this edit box, you can 

type the text that you want to find. To search for the text, press “Enter”.  

 

2. Search direction 

The next field is “Search direction? F/B”. The default direction is “F 

(Forward)”. If you want to search the document from your current cursor to 

the end, press “F (dots 1-2-4)”. If you want to search the document from 

your current cursor to the top, press “B (dots 1-2)”. Or you can press the 

routing cursor button above the F or B on the Braille display.  

 

If there are no search results, “not found” is displayed and you are returned 

to your previous position in the document.  

 

If you want to search for the same text again, press “Ctrl-shift-F (dots 1-2-

4)”, “Find again”.  

 

3.8.2 Replace  

 

To execute this command, press “Space-m (dots 1-3-4)” or “Alt” and 

navigate to “tools” by pressing “Space-4”, and press “Enter”. Move to 



 

 

“Replace” using “Space-4” and press “Enter”. While editing a document, 

pressing “Ctrl-r (dots 1-2-3-5)” activates this function. 

“Replace” opens a dialog that consists of the following fields: “Text to find”, 

and “Replace with”.  

 

1. Text to find 

Type the text that you want to replace in this field and press “Enter”.  

 

2. Replace with 

Type the replacement text in this edit box and press “Enter”.  

 

If there are search results, you are prompted, “Replace? Once or all”. If you 

want to replace once, press O (dots 1-3-5). If you want to replace all 

instances of the found text, press A (dot 1), or you can press a cursor 

routing key above your desired option. 

 

⚫ Note: the “Replace” function is available only in the forward direction. 

 

3.9 Mark 

3.9.1 Set Mark  

The “Set mark” command marks a position in the document that you want 

to return to later. You can set up to 26 marks in a document on the QBraille 

XL, defined by the letters a-z. To execute this command, move the cursor 

to the location at which you want to set a mark, and press “Space-m (dots 

1-3-4)” or “Alt”, and move to “Mark” by pressing “Space-4” and press 

“Enter”. Move to “Set mark” by pressing “Space-4”, and press “Enter. While 

editing a document, press “Ctrl-m (dots 1-3-4)” to activate this command. 

 

When the mark is inserted successfully, “successfully set mark a-z” is 

displayed. You can enter a mark name from “a” to “z”. 

 



 

 

3.9.2 Go to Mark  

The “Go to Mark” command jumps to a mark that has previously been set. 

To execute this command, press “Space-m (dots 1-3-4)”, or “Alt”, and move 

to “Mark” by pressing “Space-4” and press “Enter”. Move to “Go to Mark” by 

pressing “Space-4”, and press “Enter”. While editing a document, go to 

marked text by pressing “Ctrl-j (dots 2-4-5)”. 

 

The QBraille XL prompts, “Mark”. Type the letter of the mark name that you 

want to locate, and the QBraille XL moves the cursor to the marked 

position. You can also go to the mark directly by typing the letter of the 

mark with “f8”. 

 

3.10 Using Typing Mode 

If you type very quickly, you may find it useful to use Typing Mode so that 

you can type as fast as you wish without concern of accidentally entering 

commands while typing. To activate Typing Mode, press “Alt-K (dots-1-3)”. 

When in Typing Mode, keys like Space, Backspace and Enter cannot serve 

as modifiers. If you press Space-1, the unit will enter a space, then dot 1 as 

separate keystrokes. This will prevent you from navigating to unintended 

places or performing unintended functions as you type. Press “Alt-K” again 

to exit Typing Mode and resume normal operation. 

 

3.11 File information 

If you wish to display the status of the Notepad, or rather, the information 

for the currently open file, you can do this by pressing “Space-dots3-4”. 

After reading the file information on the Braille display, press any key to 

return to document editing. 

 



 

 

3.12 Auto scroll 

The “Auto Scroll” command scrolls the Braille display automatically by 

display length through the document.  

 

You can turn the auto scroll feature on and off by pressing the up and down 

scroll buttons simultaneously. You can also cancel auto scrolling by 

pressing the “Esc” key. You can control the speed of the auto scroll using 

“Control-Left arrow” and “Control-Right arrow”. 

 

3.13 Settings 

Use the “Settings” dialog to change available “notepad” related options. To 

open the “settings” menu press “Ctrl-E (dots 1-5)”. Or press “Space-m (dots 

1-3-4)”, or “Alt”, and move to “tools” by pressing “Space-4” and press 

“Enter”. Move to “settings” by pressing “Space-4”, and press “Enter”.  

 

Move among the available settings using “Space-4” or “Space-1”. Use 

“Space” or “Backspace” to change the value of the focused setting.  

 

1) View format character: On/off 

This option allows you to choose whether format characters such as tab 

and form feed are displayed. Formatted characters are marked as "carriage 

return ($p)", and the "mark indicator ($pl)". While editing a document, press 

“Insert-C (dots 1-4)” repeatedly to change the value of the “view format 

character” setting directly.  

 

2) Reading Unit: line/sentence/paragraph/page 

This option defines the unit of movement when pressing the "up arrow" or 

"down arrow" while reading a document. The available settings are “line”, 

“sentence”, “paragraph” and “page”. Default is set to “line”.  

 

3) Set Read only: On/off 



 

 

If this option is set to "On", the document cannot be modified. This setting 

is used to protect the document from any unintentional modifications. While 

editing a document, press “Alt-R (dots 1-2-3-5)” to change the value of the 

“Read only” setting directly.  

 

4) Auto scroll speed: 1~36 

This option sets the duration one Braille display length is shown while you 

are auto scrolling in a document. Thirty-six is the fastest scrolling speed. 

Pressing "Space" increases the scroll speed and "Backspace" decreases it. 

While auto scrolling a document press “Control-left arrow” or “control-right 

arrow” to change the value of the “Auto scroll speed” setting directly.  

 

5) Set default Document type for new documents: Braille/Text 

This option defines the default document type when creating a new 

document. You can choose between Braille and text. The default is Braille. 

 

6) Blink throughout the blocked section: On/off  

This function defines whether the cursor blinks or not when 

navigating/selecting blocked text.  

 

3.14 Managing files/folders 

To open the File Browser, Press Ctrl-O (dots 1-3-5) or “Alt” and then move 

to “file” by pressing “Space-4” and press “Enter”. Move to “file browser” by 

pressing “Space-4”, and press “Enter”. From the file browser, you can 

create, open, and manage files and folders. 

 

3.14.1 Copy and paste files and folders  

"Copy" leaves the selected files and folders in their original locations and 

creates copies of them in your chosen destinations. Use the “Copy” 

function as follows: 

1) Select the files and folders you wish to copy by pressing “space” on 

each of them.  



 

 

2) Open the menu and choose "Copy" from the list to copy the selected 

files and folders. You can execute the "Copy" command directly from 

the file list by pressing "Ctrl-C (dots 1-4)". “Copy completed” message 

is displayed.  

3) Navigate to the destination folder. 

4) Open the menu and choose "Paste". Press "Enter" on "Paste," and your 

selected files and folders are copied. You can press "Ctrl-v" to execute 

the "paste" command directly from the file list. When the paste is 

complete, “Paste completed” is displayed.  

 

3.14.2 Cut and move files and folders  

 

"Cut" removes the selected files and folders from their original locations 

and moves them to the new locations you have chosen. Use the “Cut” 

function as follows: 

1) Select the files and folders you wish to cut.  

2) Open the menu and choose "cut" from the menu list. Use "Ctrl-x" to 

execute the "Cut" command directly from the file list. “Cut completed” 

message is displayed. 

3) Navigate to the destination folder. 

4) Open the menu and choose "Paste". Press "Enter" on "Paste," and your 

selected files and folders are moved. You can press "Ctrl-v" to execute 

the "paste" command directly from the file list. When the paste is 

complete, “Paste completed” is displayed.  

 

3.14.3 Delete files and folders  

 

To delete files or folders, navigate to the folders or files that you want to 

delete, and select them using “Space”. Open the menu by pressing 

"Space-m (dots 1-3-4)" or “Alt” and choose the "Delete" option. Press 

"Enter" on "Delete" to complete the deletion of the selected files and 

folders. You can also delete selected files or folders by using hot keys; 

"Ctrl-d (dots 1-4-5)" and "space-d (dots 1-4-5)" can both be used to execute 



 

 

the "Delete" function. “Delete xxx? y/n” prompt message is displayed and 

an audio alert sound. If you want to delete the selected folders/files, press 

“Y (dots 1-3-4-5-6)”. “Delete completed” message is displayed, and the 

selected files/folders are deleted successfully. If you don’t want to delete 

the selected files/folders, press “N (dots 1-3-4-5)”.   

 

3.14.4 Selecting files/folders   

 

1. Select individual items "Space": *(dots 1-6) is displayed in front of the 

item to denote its selection. Pressing "Space" again on the selected folder 

or file cancels the selection. 

 

2. Select all ("Ctrl-a (dot 1)") 

This feature selects all the files and folders in the current list. You can 

access this feature from the menu, or by using a shortcut key; Ctrl-a (dot1) 

to select all the files and folders in the current list without entering the 

menu. To select all via the menu, press "Space-m (dots 1-3-4)" to open the 

menu. Press the down arrow ("Space-4") to navigate to "Select All". Press 

"Enter" to execute the "Select All" function. When "Select All" is activated, 

the QBraille XL says, "Select all completed". An * appears in front of each 

file name you have selected. You can cancel the selection of a file or folder 

by pressing "Space". This feature is a convenient method for selecting 

multiple files for copying, cutting, or deleting.  

 

3.14.5 Create new folder   

 

Use this option to create a new sub-folder under the current folder. Press 

"Space-m (dots 1-3-4)" or “Alt” and move to the "New Folder" option using 

“Space-4”, and press “Enter” on "New Folder" to activate this function.  

Use the hot key "Ctrl-f (dots 1-2-4)" to access this feature directly from the 

file list. 

 



 

 

QBraille XL prompts, "folder name?". Enter your preferred new folder name 

in computer Braille, and press "Enter". Your new folder is created and “new 

folder completed” is displayed. When creating a new folder name, you 

cannot use the following characters: "|, \, <, >, ?, :, *” 

 

3.14.6 Rename files and folders   

 

You can change the name of a file or folder by using this function. To 

change the name of a file or folder, move to the file or folder you wish to 

rename. Open the menu by using "Space-m (dots 1-3-4)" and choose 

"Rename" from the menu list and press "Enter". You can also use the hot 

key "Ctrl-E (dots 1-5)” to activate the "Rename" function directly from the 

file list. QBraille XL asks for a new name. On the Braille display, "New file 

(or folder) name: noname.brl" appears. You must type the new file/folder 

name in ASCII characters. Press "Enter" after entering a new file name to 

complete the renaming process. QBraille displays, “rename completed”. 

You cannot use the following characters in a file name or folder: “|, \, <, >, 

?, :, *” 

 

3.14.7 Find file or folder   

 

Use the "Find" function to locate a file or folder for which you know all or 

part of the name. You can press "Space-m (dots 1-3-4) to open the menu 

and move to "Find" and press "Enter". You can press "Ctrl-S (dot 2-3-4)" to 

activate this function directly from the file list.  

When you activate the file search, the unit prompts "File for find:" you are 

placed on the edit box for entering the file name to search". Type all or part 

of the file name and press "Enter". QBraille XL searches for all files 

containing the text you entered. When the file search is complete, you are 

placed in the results list. 

  

If you press "Enter" on a file, you are placed on the path where the file is 

stored. You can open the file by pressing "Enter" on the file name again. If 



 

 

there is no search result, “no items” is displayed and you are returned to 

the file list. If you want to cancel this function, press “Esc” key and you are 

returned to the file list.  

 

3.15 Information 

 

This function allows you to check information about a folder or file. To open 

“information”, press “Ctrl-I (dots 2-4)”. Or press “Space-m (dots 1-3-4)”, or 

“Alt”, and move to “Information” by pressing “Space-4” and press “Enter”. 

You can view size, date, time, and protection status (write/read).  

To cancel and return to the previous status, press “Esc” key.  

 

4. Connectivity 
The "Connectivity" menu allows you to manage and move among the 

various Braille Display and Keyboard connections you have established 

with your QBraille. To open the "Connectivity" menu, from the main menu, 

navigate to it with the arrow keys and press "Enter", or press the letter C. 

When you first open "Connectivity", you are asked if you want to establish a 

USB connection, Bluetooth Braille connection, or Bluetooth keyboard 

connection. Use "Space-1" and "Space-4" or the arrow keys, to make your 

choice and press "Enter". 

The final item in the Connectivity Menu is the “Pairing list”. Once you have 

established connections, you may re-activate them from this list, or by 

using shortcuts described later in this section. 

 

QBraille uses 2 connections when connecting to your PC, phone or tablet: 

a keyboard (HID) connection, and a Braille display (SPP) connection. In the 

case of USB, both are active when you use USB mode, however, you need 

to install the HIMS USB driver for Windows before you can setup the braille 

display connection with a Windows screen reader. When pairing via 

Bluetooth, each connection must be established separately. 



 

 

It is necessary to establish 2 connections as, at present, screen readers do 

not support QWERTY input from a Braille display, and each handles non-

Braille keys very differently. Although the explanation may seem confusing, 

it is rather intuitive once set up, as you can then type in your most 

comfortable Braille table and grade, yet operate your computer using the 

QWERTY commands you were taught, while having Braille output at your 

fingertips.  

 

The Keyboard, (HID) connection is recognized as a standard USB or 

Bluetooth keyboard. But it is actually utilizing the special functions of our 

Hybrid keyboard. Braille translation is performed internally, according to the 

Braille table and Braille grade you have set in the options menu of the 

QBraille. However, QWERTY keys and combinations are recognized as 

they would be on a standard keyboard. For example, to close a program in 

Windows, press "Alt-F 4", just as you would on a standard Windows 

keyboard. To turn Bold On and off in Microsoft Word, press Control-B. Yet, 

you are still able to enter and edit text using contracted braille. You can 

instantly cycle the available Braille grades for text entry for your selected 

Braille table by pressing the Mode and Pairing keys simultaneously. 

 

There may be times when you need to switch between your preferred 

grade of Braille and Computer Braille. For example, when using first letter 

navigation, or entering an e-mail address. Press the “Mode and “Escape” 

keys simultaneously to toggle between Computer braille and your “Braille 

grade for Entry” as set in the “Options” menu. 

 

The Braille (SPP connection) is the standard Braille display connection 

most screen readers recognize. This connection, when used by itself, 

allows you to use QBraille exactly as you would a traditional Braille display, 

controlling the screen reader primarily using Braille keyboard commands. 

To establish this connection, please see the subsequent sections on setting 

up QBraille with a screen reader. 

 

When both connections are established, you may activate Hybrid Mode by 

pressing the Mode key. When Hybrid Mode is active, input and commands 



 

 

are processed using the Keyboard connection, and Braille output, cursor 

routing and scrolling are processed via the Braille connection and the 

screen reader you are currently running. You can turn Hybrid Mode off by 

pressing the Mode key again.   

 

QBraille supports 1 USB and 6 Bluetooth Hybrid connections. However, 

you can switch to each separate device and connection type, for a total of 

14. 

 

To switch to any of the established Braille connections, press the Pairing 

key along withF1-F6, in which each of the function keys is associated with 

Bluetooth Braille connections 1-6. To switch to the various established 

Keyboard connections, press the Pairing key withF7-F12, in which each of 

the function keys is associated respectively with Keyboard connections 1-6. 

Use the Pairing key with Escape to switch to the USB connection.  

 

You can also interact with the various pairings using the Pairing list. Use 

the following key commands to perform their associated functions: 

• To open the pairing list, press pairing key + L. 

• Jump to a pairing by navigating to it and pressing Enter. 

• Press Space-D or the Delete key to remove a connection from the 

Pairing List. 

• Press the Paring Key from the pairing list to disconnect the current 

connection without removing from the Pairing list. 

 

To close the Connectivity area and return to the QBraille’s standalone 

programming, press Backspace-Space-Z (dots-1-3-5-6). 

 

4.1 Establishing a Connection  

If you choose "USB", you are directly placed in Terminal Mode. If you 

connect QBraille to a computer, it will automatically be recognized as a 



 

 

USB keyboard, however, no Braille output will occur automatically, unless a 

screen reader is running, the HIMS USB driver is installed, and the screen 

reader has been configured to use a HIMS Braille display.  

 

If you choose Bluetooth, Pairing Mode is initiated, and you must establish 

the Bluetooth pairing with your phone or PC. 

 

As explained previously, you can pair as a keyboard, Braille display, or 

both. The Bluetooth Keyboard device name is QBrailleXL. The Bluetooth 

Braille display (SPP) device name is “Braille EDGE”, as the Braille display 

operates using the same protocol as our Braille EDGE 40. 

 

4.2 Supported Screen Readers 

The following screen readers have been tested and are known to be 

supported. However, any screen reader that offers support for the HIMS 

Braille EDGE/BrailleSense should also support QBraille. 

1)    Jaws (Freedom scientific) 

2)    Window eyes (GW micro) 

3)    Supernova (Dolphin) 

4)    System Access (Serotek) 

5)    NVDA (NV Access) 

6)    Voice over for Mac and iOS (Apple) 

7)    BrailleBack for Android (Google) 

 

4.3 Connecting to a Screen reader 

 



 

 

4.3.1 Connecting to PC via USB 

 

To connect the QBraille XL to a screen reader such as Jaws or NVDA via 

USB, you must install the proper USB driver on your PC. Below are steps 

for installing the USB driver.  

 

1) Download the USB driver for QBraille XL from the HIMS website. 

2) Unzip the compressed file and execute 

“Braille_SENSE_USB_Driver.exe. 

3) When the “Braille Sense USB Driver Setup wizard” appears, press the 

“Install” button.  

4) When the installation wizard appears, select the “Next” button.  

5) When the drivers are successfully installed, press the “Finish” button.  

6) Connect the QBraille XL to the PC via the USB cable, and “terminal 

mode” is displayed on the QBraille.  

7) Windows will locate and automatically install the drivers.  

 When you have finished installation of the USB driver on the PC, please 

follow the instructions for connecting the display with your screen reader 

via USB. 

 

4.3.2 Connecting to PC via Bluetooth serial port 

The following steps will walk you through setting up the QBraille XL to be 

used as a Bluetooth keyboard or Terminal for Screen Reader (A Braille 

display). Before you begin, make sure that your QBraille XL is turned on 

and in pairing Mode. To enter pairing Mode, open the Connectivity menu, 

and choose either the Bluetooth Keyboard or Bluetooth Braille Connection. 

QBraille will display “Pairing Keyboard”, or “Pairing Braille”.  

 

If you have already established a Bluetooth connection, you can press the 

Pairing Key and F1-F6 to open a new Braille connection or Pairing with F7-

F12 to open a new keyboard connection. 

 



 

 

be aware of your QBraille’s designated Bluetooth name: QBrailleXL for the 

keyboard connection, and Braille EDGE for the Braille display connection. 

 

1) Open the Control Panel. 

2) Open Devices and Printers 

3) Tab to “Add a Device” and press “Enter”. 

4) Windows searches for devices and displays them in a list. 

5) Use the Up or Down arrow to navigate to the QBraille and press “Enter”. 

6) If you are asked to enter the pass code for the device; enter 0000, and 

press “Enter”. 

7) The computer should display the message, "Found new hardware" and 

the final dialog should appear on the computer. The dialog should 

display that the Bluetooth device was successfully set up. It is very 

important to note the Bluetooth COM port when setting up the Braille 

connection, as you will need this when setting up your screen reader. 

 

4.3.3 Using the QBraille with JAWS for Windows 

 

Use the following instructions to set up the QBraille XL as a Braille display 

with the JAWS screen reader from Freedom Scientific: 

1) Make sure QBraille XL is powered on, and in terminal Mode. If you are 

using USB, please connect the QBraille to your computer via the included 

USB cable. 

2) Navigate to the JAWS Window and press “Alt” to open the menu.  

3) Press “Enter” on the “Options” menu. 

4) Use the Up or Down arrow to navigate to “Braille” and press “Enter”. 

5) Choose HIMS Braille EDGE as your Braille device. 

6) Tab to “Advanced” and press “Enter”. 

7) Choose USB as the port if connecting via USB, or the correct Com Port 

if using Bluetooth. 

8) Tab to “OK” and press “Enter”. 

9) You are prompted that you must restart JAWS for the settings to take 

effect. Restart JAWS for Windows, and Braille should begin displaying. 



 

 

10) If you wish to use QWERTY operations, press the Mode key to turn 

Hybrid mode on. 

 

4.3.4 Using QBraille as a Braille display with NVDA 

Use the following instructions to set up the QBraille for use as a Braille 

display with the free NVDA screen reader from NV Access. 

1) Make sure QBraille XL is powered on, and in Terminal Mode. If you 

are using USB, please connect the QBraille to your computer via the 

included USB cable. 

2) Press “NVDA key-N” to open the NVDA menu. 

3) Arrow down to “Preferences” and press “Enter”. 

4) Arrow down to “Braille Settings” and press “Enter”. 

5) Choose “HIMS Braille Sense/Braille EDGE” from the Braille Display 

combo box. 

6) Tab to the “Port” combo box and ensure that it is set correctly. (NVDA 

employs automatic port detection, so you should not need to change 

this setting) 

7) Tab among the various combo boxes to choose options such as 

output and Input tables, cursor options, etc. Use the Up and Down 

arrows to navigate among the choices in each combo box. 

8) When you have finished choosing your settings, Tab to “OK” and 

press “Enter”. 

9) If you wish to use standard keyboard operations, press the Mode key 

to turn Hybrid Mode on. 

 

⚫ Note: Make sure the “Save configuration on Exit” box is checked in the 

NVDA menu in order to ensure your settings for the QBraille are saved, 

thus the QBraille will automatically connect each time you use NVDA in 

the future. 

 



 

 

4.3.5 Using QBraille with System Access. 

 

Currently, The QBraille works with System Access using only a Bluetooth 

connection. To use your QBraille as a Braille display with System Access, 

ensure the QBraille is powered on, and in Terminal Mode. When System 

Access is started, the QBraille is automatically detected, and Braille begins 

displaying. As with all other screen readers, press the Mode key to turn on 

Hybrid Mode to use standard QWERTY operations. 

 

4.3.6 Using QBraille with VoiceOver on the Mac. 

 

To use the QBraille as a USB braille display with a Mac running VoiceOver, 

you can simply power on the QBraille, choose the USB connection from the 

Connectivity menu, and connect it to the Mac via USB. The unit is 

immediately recognized, and VoiceOver output is shown on the Braille 

display. 

 

When connected to a Mac in Hybrid mode, the keyboard operations and 

function keys will work as a standard Mac keyboard functions. 

 

Use the following steps to connect the QBraille as a Bluetooth Braille 

display with a Mac running VoiceOver when QBraille is in Pairing Braille 

Mode: 

1. Press Vo-F8 to open VoiceOver Utility. 

2. Navigate to “Categories” and press Vo-Shift-Down to begin interacting 

with it. 

3. Press B for Braille. 

4. Press Vo-Shift-Up to stop interacting with the Categories group. 

5. Press Vo-Right to “Display”, and press Vo-Space to activate it. 

6. Navigate to “Add”, and press VoSpace to activate. 

7. VoiceOver announces, “Searching for Bluetooth devices”. 



 

 

8. Navigate to the “Bluetooth devices” list and press Vo-Shift-Down to 

interact with the table. 

9. Navigate to “Braille EDGE” and press Vo-Shift-Up to stop interacting with 

the table. 

10. Navigate to “Remember this device” and press Vo-Space to check the 

box. 

11. Navigate to “select” and press Vo-Space” to activate it. 

12. VoiceOver asks for the pairing code and places you in the edit box. 

13. Type 0000 and press “Enter”. 

You should hear a chime indicating VoiceOver has connected to your 

QBraille XL and you should begin seeing VoiceOver output on the Braille 

display.  

 

4.3.7 Using the QBraille with IOS devices 

Use the following instructions to connect the QBraille as a Bluetooth Braille 

display with your iPhone, iPad, or iPod, first ensuring QBraille is in Pairing 

Braille Mode.  

 

⚫ Note: These instructions refer to the iPhone, however, they apply to all 

compatible i-devices: iPhone 3Gs and higher, iPad, and iPod Touch 3G 

and later. 

 

On the i-Phone: 

1) Navigate to Settings/General/Accessibility/VoiceOver/Braille. 

2) If Bluetooth is not activated on the I-Phone, it will prompt you to do this. 

WHEN Bluetooth is activated, the I-Phone searches for devices. 

3) The QBraille should appear in the list of available Braille devices under 

the name “BrailleEDGE. 

4) Double tap it in the Braille devices list. 

5) You should hear a chime on the iPhone, and the text displayed on the 

iPhone should appear on the Braille display of your QBraille. 

*Note: to use Hybrid Mode, place the QBraille in Pairing Keyboard Mode, 

and connect it as you would a normal Bluetooth keyboard. Once done, 

press the Mode key to turn Hybrid Mode on. 



 

 

 

4.3.8 Using the QBraille with BrailleBack for Android. 

 
In order to use BrailleBack, you must first download and install it to your 

Android device from the Google Play store. 

Use the following steps to use your QBraille as a Braille display with 

BrailleBack, first ensuring QBraille is in Pairing Braille Mode. 

 

1. On your Android device: go to “Settings”. 

2. Select Bluetooth. 

3. Select “Search for devices”. 

4. Select the QBraille from the device list where it will appear under the 

name “BrailleEDGE”. 

5. If requested, enter the pairing code 0000. 

6. When the QBraille is successfully paired, return to “Settings” and select 

“Accessibility”. 

7. Select BrailleBack and enable the checkbox to turn it on. 

*Note: to use Hybrid Mode, place the QBraille in Pairing Keyboard Mode, 

and connect it as you would a normal Bluetooth keyboard. Once done, 

press the Mode key to turn Hybrid Mode on. 

 

4.4 Terminal Clipboard 

 

Terminal Clipboard allows you to create and edit text on the QBraille before 

sending it via the Terminal for Screen Reader to the connected device. This 

can be useful in instances like when using VoiceOver on an i-device, in 

which characters are translated as they are sent to the iPhone or iPad.  

 

Sometimes, creating/editing text when using a Braille display can be a 

tedious business. As explained above, the Terminal Clipboard allows you 

to create and edit text on the QBraille and send the completed text to the 

connected computer or Smartphone via the Terminal for Screen reader. 



 

 

 

To enter "Terminal Clipboard", press "Space-enter-I (dote 2-4)". The 

QBraille displays "Terminal Clipboard", and places you in an edit box. Type 

and edit your text using normal text entry and edit commands. In "Terminal 

Clipboard", the Braille display and keyboard are temporarily disabled from 

sending/receiving information to/from your connected computer or i-device, 

so that you may use them for creating/editing your text.  

 

For more information on text entry and editing, please see section 3 of this 

manual on the Notepad. When you are finished typing the text you wish to 

send to your computer or smartphone, press "enter”, and the text is quickly 

inputted to the device via the Terminal for Screen reader, and your QBraille 

returns to sending/receiving information to and from the connected device. 

 

5. DAISY Reader 
Using the DAISY Reader on the QBraille, you can read text-based books 

that use the DAISY format.  

 

⚫ Note: DAISY audio is not supported. DAISY is an acronym for "DIGITAL 

ACCESSIBLE INFORMATION SYSTEM” and offers advanced 

navigation features that allow the user to easily jump to various sections 

of the book including sections, subsections, chapters, pages or 

paragraphs.  

 

5.1 Executing the DAISY Reader 

To launch the DAISY Reader, press "Enter" on "DAISY Reader" in the 

QBraille main menu, or by pressing the letter D. When you launch the 

DAISY Reader, you are placed in QBraille’s folder list. Use normal folder 

navigation to locate the folder containing a DAISY book you want to open.  

 

Press "Space" to select it, then press "Enter" to open it. You must first 

select the folder containing the book, because a DAISY book contains 



 

 

multiple files, thus, QBraille needs to know exactly from which folder to get 

all the book text and information.  

 

If you open a book that you have read before, reading resumes from the 

location where you last exited. To stop reading a DAISY book, press 

"Space-Z". A prompt box appears asking if you would like to exit the DAISY 

Reader. Select "Yes" or "No" with "Space" or "Backspace" and press 

"Enter".  

 

Open the DAISY Reader menu by pressing "Space-M" or "Alt". The menu 

contains "File", "Document", "Mark", and "Heading". You can navigate the 

menu items using "Space-1" and "Space-4" or the arrow keys. To activate 

a menu item, press "Enter".  

 

Or, you can press "Space-M or "Alt" followed by the shortcut for the 

corresponding menu item.  For example, to open the "Heading" menu, 

press "Space-M" or "Alt" to open the   menu, and press H.  

 

The DAISY Reader also contains various lists and dialog boxes. Use 

"Space-1" and "Space-4" or the Up and Down arrow keys to navigate 

menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "Tab and 

"Shift-Tab", to move among controls in a dialog. For the purposes of these 

instructions, we will generally refer to using "Tab" and "Shift-Tab". 

 

However, in these instances, "Space-4-5" and "Space-1-2" can also be 

used. Press "Enter" to execute an item. 

 

5.2 The File Menu 

 

5.2.1 File Browser 

You can open another DAISY book using the File Browser. Select "File 

Browser" from the "File" menu, or press "Control-O" from the playback 



 

 

dialog. The folder list is displayed as when you first open the DAISY 

Reader. 

 

5.2.2 File information 

You can query the information on the currently playing book. Select "File 

information" from the "File" menu or press "Control-I" from the playback 

dialog.  

 

The "Book-Info" dialog contains a status box with pages", another status 

box containing the "mark information", and a "Close" button. The first status 

box contains "Total pages", "Current page", and "Remaining pages". The 

second status box contains the "Total marks" and "Mark page".  

 

5.2.3 Exit 

To exit the DAISY Reader, press "Enter" on "Exit" in the "File" menu, or 

press "Space-Z".  

 

5.3 Document Navigation 

 

5.3.1 Move by Page 

Select "Move to Next Page", "Move To previous Page" or "Go to Page" 

from the "Document" menu.  Or, press "Space-3-4-5" or "Space-1-2-6" to 

move by page during playback. `Go to Page" by pressing "Enter-G". When 

you activate "Go To Page", you are prompted "Move to page number?" 

Type the number of the page you want to move to in the edit box and press 

"Enter".  

 



 

 

5.3.2 Move by unit 

Select "Next Movement Unit" or “Previous Movement Unit" from the 

"Document" menu, or press "dot 6" or "dot 3" during playback. 

 

5.3.3 Changing movement Units 

Select "Change Previous Movement Unit" or "Change Next Movement unit" 

from the "Document" menu, or by pressing "dots 5-6" or "dots 2-3" during 

playback. The movement unit options depend on what navigation elements 

are present in the current book.   

 

5.4 Marks 

 

5.4.1 Set Mark 

You can set marks while playing a file to note positions you would like to 

return to later. You may set up to 1000 marks per DAISY book. You can set 

a mark by pressing "Control-M" during playback or by choosing "Set Mark" 

from the "Mark" menu. 

The "Set Mark" dialog opens, and you are prompted to "Enter mark name:". 

Enter the number of the mark that you want to insert from 1 to 1000 and 

press "Enter". 

 

5.4.2 Go to Mark 

You can move to a specific mark by pressing "Control-J", or by selecting 

"Go to Mark" from the "Mark" menu. You are prompted for the "Mark name 

to move to:". Type the mark name in the edit box and press "Enter". If you 

have not previously set a mark, you cannot use this function.  

 



 

 

5.4.3 Deleting a Mark 

You can delete a mark using "Control-D" during playback, or by selecting 

"Delete Mark" from the "mark" menu. You are prompted to "Enter mark 

name to delete". Type it and press "Enter".  

 

5.5 Heading 

 

5.5.1 Move to Specific Heading 

To move to a specific heading, press "Control-H" during playback. The 

QBraille displays a list of the headings in the DAISY book with focus on the 

heading you are currently reading. Use "Space-1" and "Space-4" to 

navigate to the heading you want to move to, and press "Enter". 

 

5.5.2 Read Heading 

During reading, you can read your current heading. You can query the 

current heading by pressing "Control-W" The current heading name and 

level are displayed.  

 

5.5.3 First and Last Heading 

While reading a DAISY book, you can move heading by heading using hot 

keys. You can move to the first or last heading by pressing "Space-1-3" 

and "Space-4-6" respectively.    

 

 

5.6 Tools 

 



 

 

5.6.1 Find 

You can activate the "Find” function by pressing "Control-F". You are 

prompted, "Text to find:" You are placed in an edit box into which to type 

text. Type the text for which you wish to search, and press “Enter”. 

Press “Control-Shift-F” to “Find Again”. 

6. Applications 
 

To open “Applications”, navigate to “Applications” using “Space-1” or 

“Space-4” and press “Enter”. You can also execute “Applications” from the 

main menu by pressing “A (dot1)”. 

 

Applications includes 6 utility programs: calculator, Alarm, Date and time, 

Stop Watch, count down and scheduler. You can move among the items in 

the applications list by pressing “Space-1” or “Space-4”  

 

6.1 Calculator 

The Calculator can perform the four fundamental arithmetic operations, 

save calculations as a file, and copy and paste calculations. 

To open the calculator, from within “Applications”, move to the “Application” 

using the “Up” or “Down arrow”, and press “Enter”.  

 

⚫ Note: when using the Calculator, you must use computer Braille. 

 

6.1.1. General functions 

 

When you launch the “Calculator”, number 0 is displayed. Use computer 

Braille to input numbers. Press “Enter” to emulate the Equal sign”. To input 

a new calculation, press “Enter”. If you want to review previous calculations 

and results, press the “up arrow”. While reviewing previous calculations, if 

you want to use this calculation to perform another calculation, move your 

cursor to the desired location and change the number, and press “Enter”.  



 

 

 

Use the following keystrokes in the Calculator: 

1) View calculation result (=): Enter 

2) Type new calculation: Enter 

3) Plus: dots 3-4-6 

4) Minus: dots 3-6 

5) Multiply by: dots 1-6 

6) Divided by: dots 3-4 

7) Percent: dots 1-4-6 

8) Power: dots 4-5-7 

9) Decimal point: dots 4-6 

10) Left parenthesis: dots 1-2-3-5-6 

11) Right parenthesis: dots 2-3-4-5-6 

 

⚫ Note: To input a negative number, surround the negative number with 

parentheses. For example, when you type -2, press dots 1-2-3-5-6, dots 

3-6, dots 1-2 and dots 2-3-4-5-6.   

 

Immediately after you input percent (%) sign in the calculator, the result is 

displayed according to the percent value by dividing the original number by 

the number before the percent (%) sign.  

 

For example, if you want to calculate 90+20%, as soon as the percent (%) 

sign is entered, the percent value is immediately calculated, and 18, is 

displayed as twenty percent of 90 is 18. Finally, the result of the calculation 

is 108. 

 

However, when you place a multiplication sign before percent sign, for 

example, 20*40%, as soon as you enter the percent (%) sign, 0.4 is 

immediately displayed, as 40% equals 0.4. The final result of the entire 

calculation is 9 multiplying 20 by 0.4.   

 



 

 

6.1.2 Clear All 

 

If you wish, you can delete all previously saved calculations and initialize 

the calculator. To do this, open the menu by pressing "Space-m (dots 1-3-

4)" or press "Alt". Then, use "Space-1" or "Space-4" to move to "Clear all", 

and press "Enter". Or you can activate this function by pressing “Ctrl-E 

(dots 1-5) directly from within in the calculation line.  

 

6.1.3 Save file 

 

The “Save file” function allows you to save the current calculations and 

results to a file for future use. This may be useful if you are balancing your 

checkbook and wish to keep a record of all of the entries, calculations, and 

results. 

 

To activate this function, press “Space-m (dots 1-3-4) or “Alt”. Then, use 

“Space-1” or “Space-4” to move to “Save file”, and press “Enter”. Or you 

can activate this function by pressing “Ctrl-S (dots 2-3-4) directly while in 

the calculation line. 

 

When the dialog is opened, "Result.brl" is automatically displayed in the file 

name edit box.  

 

You can keep the default file name or type another of your choosing in to 

the edit box. When you have finished typing your file name. Press “Enter”, 

and the file is saved to the root of your SD card. 

If you want to cancel the “Save file” function, press “Esc”.   

 

6.1.4 Copy and paste 

 



 

 

To copy the calculation on the current line to the clipboard, press “Ctrl-C 

(dots 1-4)” 

 

You can then paste the calculation to another place in the Calculator, or 

you may paste it to a document in the Notepad. 

 

You can paste the calculation by pressing “Ctrl-V (dots 1-2-3-6)”. You can 

also copy just the most recent result to the clipboard by pressing “Ctrl-R 

(dots 1-2-3-5). This function is different from the “Copy calculation” 

function, as this function saves only the last result.   

 

6.2 Alarm 

 

You can set an "Alarm" so that it sounds on the QBraille XL at a specified 

time for a single occurrence, once a week, or every day. 

To open "Alarm" from the Main menu, use "Space-1" or "Space-4" to 

navigate to "Applications", and press "Enter". Move to the “Alarm” by using 

“Space-4” or “Space-1”, and press “Enter”.  

 

If this is the first time you have opened "Alarm", and you have not yet set 

the time or date in the QBraille XL, the unit prompts, "Set time:(00:00)".  

  

6.2.1 Set Time 

 

When you execute “Alarm”, you are placed on the “hour”. You can type the 

time directly or use “Up/down arrow” and “Left/right arrows” to input time. 

Then, press “Enter” or “Right arrow” to save the “Time” and move to the 

“Term” setting. 

 

Use the keystrokes below to adjust the time: 

Left/Right arrow: move the cursor to hour or minute 



 

 

Up/Down arrow: change the time value 

 

6.2.2 Term 

 

Use the “Term” setting to define just when the alarm sounds. There are four 

options: "Off", "Once", "Week days", and "Every day". Move among these 

options by pressing "Space-1" or "Space-4". If the "Term" is set to "Off", the 

alarm does not sound at the specified time no matter how the other options 

in the dialog are set. If the "Term" is set to "Once", the alarm sounds only 

once. If the "Term" is set to "Week day", the alarm sounds at the same time 

every weekday, Monday through Friday. If the "Term" is set to "Everyday", 

the alarm sounds at the specified time 7 days a week. When you have 

selected your preference, press "Enter" or “Right arrow” to move to the next 

field. 

 

6.2.3 Duration 

 

This option sets the amount of time that the alarm sounds. You can choose 

duration time from 1 minute to 9 minutes the default is 5 minutes. You can 

type the duration in minutes directly. Or you can move among these 

options by pressing “Backspace" / “Space” or “Up arrow” / “Down arrow”. If 

you set the ringing duration to "1 minute", the alarm sounds for one minute, 

then the unit is silent. When you have selected your preference, press 

"Enter" or “Right arrow” to move to the next field. 

 

6.2.4 Wake-up call times 

 

This option allows you to decide how many times the alarm sounds. If the 

alarm is not turned off by pressing "Backspace-enter", it repeats according 



 

 

to the number of times you set for this option. The available settings are 1 

to 5 and default is 3 times. Move among these options by pressing 

“Backspace" / “Space” or “Up arrow” / “Down arrow”. When you have 

selected your preference, press "Enter" or “Right arrow” to move to the next 

field. 

 

6.2.5 Repeat Interval 

 

This option sets the amount of time between the times that the alarm 

sounds. For example, if you set the repeat interval to three minutes, after 

the alarm has stopped sounding, it rings again in 3 minutes. The available 

settings are from 1 minute to 9 minutes and default is 5 minutes. Move 

among these options by pressing “Backspace" / “Space” or “Up arrow” / 

“Down arrow”.  

As this is the final setting, pressing “Enter” completes the setting of the 

alarm and exits the “Alarm” dialog. 

, if you want to cancel setting the “Alarm”, press “Esc”.  

 

6.2.6 Stop Alarm Sound 

 

When the alarm sounds, the Braille display also displays the message 

"Alarm stop? Stop or Yes to all". If you want to stop 1 occurrence of alarm, 

press “ENTER”. (The current cursor is located on the “stop” option.) 

If you want to stop the alarm completely so that it does not repeat at the 

specified time for the specified number of wake-up calls, move the cursor to 

the “Yes to all” option and press “ENTER” or press the cursor routing 

button twice. 

 

Press “Space” / “Backspace” or “Space-1” / “Space-4” to change the cursor 

location to the different options and then press “ENTER”. 



 

 

 

6.3 Date and Time 

 

You can check and set date and time in the “Date and Time” application. 

To open “Date and Time”, move to “Applications” by using “Space-4” or 

“Space-1”, and press “Enter”. Move to the “Date and Time” by using 

“Space-4” or “Space-1”, and press “Enter”.  

When “Date and Time” is executed, time, day, month, date and year are 

displayed. To close “Date and Time”, press “Esc”.  

  

6.3.1 Set the date and time 

 

To set or change date and time, press Ctrl-S (dots 2-3-4). Or press “Space-

m (1-3-4) or “Alt” and move to “Set(s)” using “Space-4”, and press “Enter”. 

You can type the time directly or use the “Up/down arrows” to select time 

values., Press “Enter” or “Right arrow” to save the “Time” and move to the 

“Date” setting. 

 

To set the date, type the correct year, month and day as mmddyyyy. For 

example, if you want to set the date as January 1st, 2012, type 01022012. 

To edit the date, route your cursor to the place you want to correct and type 

the date value.  

 

Use the following keystrokes to navigate and set Time and date values: 

- Left/Right arrow: Move the cursor among hour/minute/date 

- Up/Down arrow: change the time or date value 

 



 

 

When you have set all the values correctly, press “Enter” to save the time 

and date.  

   

6.3.2 Time and Date Options 

 

You can open the options menu with “ALT” key or “Space-m (dots 1-3-4)” 

and move to “Options” by using “Space-4” or “Space-1”, and press “Enter”. 

You can also use “Ctrl-o (dots1-3-5)” to activate this function directly. In this 

dialog, you can choose “Time zone”, “Use daylight savings” and “Time 

format”.  

 

When you open "Options" for the first time, you are placed on "Time zone”. 

You can review the "time zone" list by pressing "Space" or by typing the 

first letter of time zones or represented cities. Select your time zone and 

move to the next item by pressing “Down arrow”.  

 

The "Use Daylight Saving" check box is displayed. You can check and 

uncheck this item using "Space". When you have selected your preference, 

press the “Down arrow”.  

 

The next item is "Time format", the options for which are 12 hour and 24-

hour time. You can toggle between the two using "Space".  

When you have set all options, press “Enter” to save your settings.  

 

6.4 Stop Watch 

 

To open the “Stop watch”, move to “Applications” by using “Space-4” or 

“Space-1” from the main menu, and press “Enter”. Move to the “Stop 

Watch” by using “Space-4” or “Space-1”. When you press "Enter" on the 

"Stopwatch", "00:00:00" is displayed.  

 



 

 

Press "Enter", to start the stopwatch running. Press "Enter" again, to stop.  

While the stopwatch is running, press "Space", to pause, and the QBraille 

XL displays the elapsed time in Braille. Pressing "Space" again restarts the 

stopwatch running. 

 

If you press "Backspace" while the stopwatch is paused or running, the 

QBraille XL clears to "00:00:00".  

 

6.5 Countdown Timer 

 

To open the “Countdown Timer”, move to “Applications” using “Space-4” or 

“Space-1” from the main menu, and press “Enter”. Move to the “Countdown 

Timer” by using “Space-4” or “Space-1”. When you press “Enter” on the 

“Countdown Timer”, "00:00:00" is displayed and you are placed on the 

hour. You are asked to type hours, minutes, and seconds. You can type the 

time directly or change the time values using the “Up arrow” or “Down 

arrow”.  

 

When typing the hours, minutes, and seconds, type a two-digit number for 

the hour, 2 digits for the minute, and 2 digits for the second using Computer 

Braille. You do not need to use a number sign. If you press "Enter" without 

typing a specified value, the "Countdown timer" starts counting down from 

the default time of one minute. When started, the "Countdown timer" 

displays "countdown xx minute” and continues displaying the remaining 

time as it counts down. 

 

Press "Enter" on the "Countdown timer", and the QBraille displays the 

remaining time, and stops the countdown. Press “Enter” once more to 

restart the countdown. Pressing "Backspace" clears the "Countdown timer". 

If the timer reaches zero, a 10-second alarm sounds, and the "Countdown 

timer" clears. If you press one of the keys or buttons while the alarm is 

sounding, the alarm stops, and your timer clears, and is ready to accept a 

new time. 



 

 

 

6.6 Scheduler  

 

6.6.1 View Calendar 

When you execute “Scheduler”, the calendar is displayed in a table which 

includes month, year, week and date. 

When you open the “Scheduler” for the first time, you are placed on the 

current week.  

 

The week starts on Sunday and ends with Saturday and today’s date is 

displayed in brackets. 

 

To navigate the calendar by weeks, route the cursor to the Week field and 

press the “Up arrow” or “Down arrow”. If you want to move by months or 

years, route the cursor to the month or year field, and press the “Up arrow” 

or “Down arrow” 

 

If a date has appointments scheduled, an asterisk is displayed in front of 

the date. 

 

To check the appointment details for a given day, press “ENTER” on the 

date. Appointments are arranged in chronological order and are displayed 

with time, alarm and subject.    

 

The Scheduler menu contains 8 items. Open the menu by pressing “Alt” or 

“Space-m (dots 1-3-4)”.  

 

The Scheduler menu contains the following options: “New Appointment”, 

“Modify Appointment”, “View All Appointments”, “Search appointments”, 

“Delete appointment”, “Copy Appointment”, “Backup appointments” and 

“Restore appointments”.  



 

 

 

You can move among the menu items using the “Up arrow”/“Down arrow” 

or “Space-4”/“Space-1”. To execute a menu item, press “Enter” or “Cursor 

routing key” twice.  

 

6.6.2 New appointment 

 

To add a new appointment, move the cursor to the desired date and press 

Ctrl-N (dots 1-3-4-5)” or “ENTER”. Or, press "Space-m (dots 1-3-4)" or "Alt" 

to open the menu. Select "New appointment", and press "Enter". The "New 

appointment" dialog contains the following fields: “Date”, “Time”, “Alarm 

time” and “Subject”.  

 

1) Date 

Input the date as mmddyyyy, month, day and year. Press “Up arrow” or 

“Down arrow” to change the date values or type the number directly. You 

can also route your cursor to what you want to edit. Once the desired date 

is displayed, press “ENTER” to move to the next item. 

 

Use the following keystrokes to navigate and change the date values. 

- Left/Right arrow: move the cursor among date, month and year 

- Up/Down arrow: change the date value  

 

2) Time 

Press “Up arrow” or “Down arrow” to change the time. Or, type the time 

directly as hhmm. You can also route your cursor to what you want to edit. 

After setting the time of the appointment, press “ENTER” to move to the 

next item. 

 



 

 

3) Alarm Time 

You can set the alarm time using the “Up arrow” or “Down arrow”. Or, type 

the value directly (the maximum alarm time is 47:59, or 47 hours and 59 

minutes before the appointment). The default alarm value is “off”. If you 

want the alarm to sound at the time of the appointment, choose “Time of 

appointment”. Once you have set your desired alarm time, press “Enter” to 

move to the next item.  

 

4) Subject 

Type the subject of your appointment, or rather, a description of the nature 

of your appointment. When you have entered or set all the information for 

your appointment, press “ENTER” to save the appointment.    

 

6.6.3 Modify appointment 

 

You can modify an appointment that you have previously added. To do this, 

move to the appointment you want to modify. Then press Ctrl-m (dots 1-3-

4)”. Or, open the menu by pressing "Space-m (dots 1-3-4)" or "Alt" and 

press "Enter" on "Modify Appointment". This dialog contains the same 

fields as in the "N appointment" dialog. The only difference is that each field 

has the value you entered when creating the appointment. Edit the values 

using the same commands as when creating the appointment. If you have 

made changes you wish to save, press "Enter".  

 

6.6.4. View All appointment 

 

You can view all the appointments you have previously scheduled. When 

you are in the calendar view, press “Ctrl-A (dot 1)”. Or, open the menu by 

pressing "Space-m (dots 1-3-4)" or "Alt" and press "Enter" on "View All 

Appointment". 



 

 

When all appointments are displayed, you are placed on the newest 

appointment. You can move through appointments using the “Up arrow” or 

“Down arrow”. Appointments are displayed as “Date: mm-dd-yyyy, Time: 

hh:mm, Alarm time: hh:mm”.  

 

To move to the first appointment in the list, press “Space-1-3” or “Up Arrow-

Left arrow”. To move to the last appointment in the list, press “Space-4-6” 

or “Down Arrow-Right arrow”. 

You can access all the functions of the Scheduler while viewing 

appointments. 

 

6.6.5 Search appointment 

 

You can activate “Search appointment” by pressing "Ctrl-F (dots 1-2-4)". Or 

you can open the menu by pressing "Space-m (dots 1-3-4)" or “Alt”, and 

press "Enter" on "Search appointment". You can search for appointments 

using keywords in the subject field. When you press "Ctrl-f (dots 1-2-4)", 

the QBraille XL prompts, "Find?”. Type the keyword you wish to find in the 

subject of an appointment and press “Enter”. Appointments in the results 

list are displayed in the same way as the “View All appointment” list.  

 

6.6.6 Delete appointment 

 

To delete an appointment, move the cursor to the date which contains an 

appointment you want to delete. Press "Space-m (dots 1-3-4)" to open the 

menu, and press "Enter" on "Delete Appointment". Or you can press its hot 

key, "Ctrl-d (dots 1-4-5)" from the appointment list. You are asked if you’re 

sure you want to delete the selected appointment. To confirm deletion of 

the selected appointment, press “Y (dots 1-2-3-6)” or, when your cursor is 

placed on “Yes”, press “Enter”. If you don’t want to delete the selected 



 

 

appointment, press “N (dots 1-3-4-5)” or, move your cursor to “No”, and 

press “Enter”.  

  

6.6.7 Copy and paste appointment 

 

You can copy appointments stored in the "Scheduler" to a document in 

notepad. Navigate the cursor to the specific appointment you want to copy 

from the Calendar view, “View all appointment” or “Search appointment” 

list. Open the menu by pressing "Space-m (dots 1-3-4)" or "Alt, and select 

"Copy appointment", and press "Enter". Or, press "Ctrl-c (dots 1-4)" to 

activate this function directly. You can then paste the appointment to a 

document in the Notepad by pressing “Ctrl-V (dots 1-2-3-6)”. 

 

6.6.8 Backup appointment 

 

The “Backup” function creates a backup of all appointments and saves the 

backup on the unit. To backup your appointments, open the menu by 

pressing "Space-m (dots 1-3-4)" or "Alt". Then, use the up and down 

arrows ("Space-1" or "Space-4"), to navigate to "Backup appointment". Or, 

you can press "Ctrl-b (dots 1-2)" to activate the “Backup” function directly. 

 

6.6.9 Restore appointment 

 

To restore your appointments from a previous backup, press "Space-m 

(dots 1-3-4)" or "Alt" to open the menu and use the up and down scroll 

buttons to locate "Restore Appointment". Then, press "Enter". You can also 

press "Ctrl-r (dots 1-2-3-5)" to activate this function directly. 



 

 

⚫ Note: If you activate the "Restore Appointment" function, and the 

backup file contains appointments that also exist in your current file, you 

will have redundant appointments.  

 

7. Options  
 

To change your QBraille XL preferences/options, move to “Options” by 

pressing “Space-4” repeatedly, and press “Enter” or just press “O (dots 1-3-

5)” from the main menu.  

You can move among the items in the settings list by pressing “Space-1” or 

“Space-4”. You can change the value of a setting using Space or 

Backspace. If you want to save the options, press “ENTER” if you want to 

exit the “Options” without saving changes, press “Esc”.  

 

The following are the settings that can be changed: 

 

1. Eight dot mode: On/Off 

This option allows you to set your Braille mode to 6 dot mode or 8 dot 

mode. The default is “Off”. If this option is set to “On”, all the upper case 

characters are displayed with dot 7 on the Braille display. Use “Space” to 

toggle this option. If you want to cancel the option setting, press “Esc” key 

and you are returned to the main menu. 

 

2. View Shortcut keys: On/Off 

This option defines whether shortcut keys are displayed after menu items. 

The default is on. If you change this option to off, shortcut keys are not 

displayed with each menu option. 

Use “Space” to toggle this item on/off. Press “Enter” to save the setting. To 

cancel without saving, press “esc”, and you are returned to the main menu. 

 

3. View File information: On/Off 



 

 

This option allows you to choose whether or not file/folder attributes are 

shown in the file browser. The default is “Off”. If this option is set to “Off”, 

only the file name and item number are displayed. Ex) “noname.brl 1/1” 

If this option is set to “On”, “file name”, “size”, “build date” and “item 

number” are displayed. Ex) “noname.brl ob 01:01:2009 1/1” 

Use “Space” to toggle this option. Press “Enter” to save the setting. If you 

want to cancel the option setting, press “Esc” key and you are returned to 

the main menu. 

 

4. Startup Mode: Main menu/New document / Terminal for Screen 

Reader/Calculator 

This option allows you to choose the program to be executed when 

QBraille XL boots up. For example, if this option is set to “New document”, 

QBraille XL launches “New document” as soon as the unit is turned on and 

you can type data into the document. Default is “Main Menu”. Use “Space” 

to toggle this option. If you want to cancel the option setting, press “Esc” 

key and you are returned to the main menu. 

⚫ Note: This option applies when the QBraille XL boots from a soft or hard 

reset. It does not apply when using the Power button to power off/on the 

unit, as this operation returns you to the position at which you powered 

the unit off. 

 

5. Play Sound: On/Off 

This option allows you to choose whether the QBraille XL provides audio 

alerts. If this option is set to “Off”, alert sounds and signal sounds are not 

heard. The default is “On”. Use “Space” to toggle this option. If you want to 

cancel the option setting, press “Esc” key and you are returned to the main 

menu. 

 

6. Braille grade for messages: Contracted/Uncontracted/Computer Braille 



 

 

This option lets you choose what grade of Braille you want to use when 

viewing messages. The available settings are Computer Braille, US 

Uncontracted Braille, US Contracted Braille, UEB Uncontracted Braille and 

UEB Contracted Braille. You can cycle among the settings by pressing 

“Space”. If you want to cancel the option setting, press “Esc” key and you 

are returned to the main menu. 

 

7. Braille Table: Spanish / French / Germany / Italian / US English / UK / 

UEB/Polish / Denmark / Turkey / Hebrew 

This option allows you to choose which Braille table is used when opening 

.brl files in the Notepad. Available settings are “Spanish”/ “French”/ 

“German”/ “Italian”/ “English”, “UK”, “Polish”, “Denmark”, “Turkey” and 

“Hebrew”. The default is “English”. Use “Space” to cycle through the 

available options. If you want to cancel the option setting, press “Esc” key 

and you are returned to the main menu. 

 

8. Message Display Time: Ignore / 1sec / 2sec / 3sec / 4sec / 5sec / Stand 

by  

This option defines how the QBraille XL deals with system messages. You 

can set the unit to ignore system messages, to stand by until you press a 

key, or, you can define how long the message remains on the display 

before automatically disappearing.  

The available settings are “Ignore”, “1sec”, “2sec”, “3sec”, “4sec”, “5sec”, 

and “Stand by”.  

 The default setting is “3 seconds”. Use “Space” to increase the message 

display time by one second. If this option is set to “standby”, the message 

remains indefinitely until you press a key. If you choose “Ignore,” messages 

are ignored and do not appear on the display. 

 

9. Power Saving Mode: On/Off 

This option allows you to choose whether QBraille XL automatically enters 

power saving mode after 10 minutes of inactivity. If this option is set to 



 

 

“On”, QBraille XL automatically goes into power saving mode, when the 

unit is not used for 10 minutes. The default is set to “On”. Use “Space” to 

toggle this option. If you want to cancel the option setting, press “Esc” key 

and you are returned to the main menu. 

 

10. Braille Grade for Entry: Contracted/Uncontracted/Computer Braille 

This option lets you choose what grade of Braille you want to use when 

viewing/editing documents in the notepad and/or typing in Hybrid Mode. 

The available settings are Computer Braille, US Uncontracted Braille, US 

Contracted Braille, UEB Uncontracted Braille and UEB Contracted Braille. 

You can cycle among the settings by pressing “Space”. If you want to 

cancel the option setting, press “Esc” key and you are returned to the main 

menu. 

 

11. Auto Disconnect from Bluetooth at 10% 

This option allows you to choose to have the QBraille automatically 

disconnect from a Bluetooth device at 10% of battery power. You may wish 

to do this in order to preserve Bluetooth settings as these are lost when the 

battery is completely depleted. Automatically disconnecting at 10% allows 

you time to locate a charging source without continuing to drain your 

battery. The available options are “On” or “Off. By default, this option is set 

to “Off”. Use “Space” to toggle this option. If you want to cancel the option 

setting, press “Esc” key and you are returned to the main menu 

 

12. Bluetooth on/Off: 

This option lets you save battery life by turning Bluetooth off if you aren’t 

using it. 

 

13. Initialize Pairings On/Off: 



 

 

This deletes all saved pairings. Press Space to turn it on, and the pairings 

will be initialized once you’ve pressed Enter to save your options. To 

initialize the pairings, the unit will be powered off. 

 

14. One-handed Mode: On/Off 

Choose whether to operate the QBraille using One-Handed mode. You can 

also toggle One-handed Mode on and off from the Main Menu using 

“Backspace-dots-1-2-3”. See section 2.11 for detailed information on one-

handed operation. 

 

15. keyboard Layout: Microsoft/Apple 

Choose the layout of the bottom row of the QWERTY keyboard to resemble 

a traditional Windows or Mac keyboard layout. 

 

16. mass storage device Mode: On/Off. 

This setting toggles whether the QBraille’s Sd card is seen as a drive when 

connected to a computer. If set to On, USB Braille display connectivity 

cannot be used, and the files on the SD card are not accessible to the 

QBraille via the Notepad or DAISY player. You can also turn mass Storage 

Mode on or off from the Main Menu by pressing “Mode-Space”. 

 

17. Restore: Automatically/initialize 

 

This option lets you set QBraille XL to Restore settings automatically on 

reset or initialize all settings. The default is set to “Restore automatically”. 

Use “Space” to cycle through the options. If you want to cancel the option 

setting, press “Esc” key and you are returned to the main menu.  



 

 

   

8. Information  
 

Information is the last item in the QBraille XL’s main MENU. To get to 

information, press “Space-dot1 or Space-dot4” and press “ENTER” on 

Information. Or you can press the hot key “I (dots 2-4) to open Information, 

regardless of your menu location.  

 

The “information” dialog displays 4 items: 

1) SD card memory: total space, remaining space 

2) Power status: battery level, power source (adapter/battery)  

3) Firmware version: Version number, build date 

4) Bluetooth: Bluetooth name (QBraille 000000), pin code (0000) 

 

You can navigate among the “Information” items using the up/down Arrows 

or Space-1/Space-4.  

You can use the following hot keys to check the information items from 

anywhere on the unit: 

SD card memory: Space-s (dots-2-3-4) 

Power status: Space-p (dots-1-2-3-4) 

Firmware version: Space-v (dots-1-2-3-6) 

Bluetooth status: Space-b (dots1-2) 

 

9. Command Summary 
 

General shortcuts 

Move to the next item in a menu or list: down arrow or Space-4 

Move to the previous item in a menu or list: up arrow or Space-1 

Move to the first item in a menu or list: Home or Space-1-3 

Move to the last item in a menu or list: End or Space-4-6 



 

 

Move to the next 40 items: Page Down or Space-3-4-5 

Move to the previous 40 items: Page Up or Space-1-2-6 

Execute program: Enter, or cursor routing key twice 

Enter sub folder: Enter, or cursor routing key twice 

Cancel: Esc key or space-E 

Exit: Space-z (dots 1-3-5-6) or Esc key. 

Enter folder or open file: Enter 

Move back a level in the folder structure: escape or Backspace 

Open the menu: Space-1-2-4 or Alt 

Check capacity of SD card: Space-S  

Check battery status: Space-P 

Check firmware version: Space-V  

Check Bluetooth status: Space-B 

Check Date and Time: Space-T 

Open Options menu: Space-O 

Open onboard Help: Space-H 

Toggle Mass storage Mode On/Off: Space-Mode 

 

Notepad 

Open new document: Ctrl-N (dots 1-3-4-5) 

Open recent document: Ctrl-P (dots 1-2-3-4) 

Open document in “read only” mode: Ctrl-R (dots1-2-3-5) 

Move to previous line: Space-1 or up arrow.  

Move to next line: Space-4 or down arrow.  

Move to beginning of line: Space-1-3 or Home 

Move to end of line: Space-4-6 or End 

Move to previous paragraph: space-2-3 or Ctrl-up arrow.  

Move to next paragraph: Space-5-6 or Ctrl-down arrow.  

Move to previous page: Space-1-2-6 or Page Up 

Move to next page: Space-3-4-5 or Page Down 

Move to the top of the document: Space-1-2-3 or Ctrl-Home 

Move to the end of the document: Space-4-5-6 or Ctrl-End 

Start block: Ctrl-B (dots 1-2) 



 

 

Select all: Ctrl-A 

Cut block: Ctrl-X (dots 1-3-4-6) 

Copy: Ctrl-C (dots 1-3) 

Paste: Ctrl-V (dots 1-2-3-6) 

Delete current character: Alt-C (dots 1-3) 

Delete current word: Alt-W (dots 2-4-5-6) 

Delete current line: Alt-L (dots 1-2-3) 

Delete block: Space-D (dots 1-4-5) 

Undo: Ctrl-Z (dots 1-3-5-6) 

Insert today’s date: Insert-d (dots1-4-5) 

Insert current time: Insert-t (dots2-3-4-5)  

Insert calculation and result: Insert-R (dots1-2-3-5),  

Find: Ctrl-F (dots 1-2-4), 

Replace: Ctrl-R (dots 1-2-3-5) 

Set Mark: Ctrl-M (dots 1-3-4). 

Move to Mark: Ctrl-J (dots 2-4-5) 

Auto scroll: up scroll button-down scroll button 

View format character: Insert-C (dots 1-4) 

Set Read only: Alt-R (dots 1-2-3-5) 

Auto scroll speed: Shift-left arrow or Shift-right arrow 

Copy file/folder: Ctrl-C (dots 1-3) 

Cut file/folder: Ctrl-X (dots 1-3-4-6) 

Paste file/folder: Ctrl-V (dots 1-2-3-6) 

Delete file/folder: Ctrl-D (dots 1-4-5) 

Select all file/folders: Ctrl-A  

Create new folder: Ctrl-F (dots 1-2-4) 

Rename file/folder: Ctrl-E (dots 1-5) 

Find file/folder: Ctrl-S (dots-2-3-4) 

Information: Ctrl-I (dots 2-4) 

 

Connectivity 

Turn Hybrid Mode on/off: Mode key 

Change Braille grade for keyboard entry: Pairing-Mode key 



 

 

Switch to USB connection: pairing-Escape 

Change to Bluetooth braille connections: pairing-F1/F6 

Change to Bluetooth keyboard connection: Pairing-F7/F12 

Close Connectivity: Backspace-Space-Z (dots-1-3-5-6) 

 

DAISY Reader 

Open DAISY book: Enter-o (dots 1-3-5) 

Check book-info: Enter-i (dots 2-4) 

Exit: Space-z (dots 1-3-5-6) 

Go to beginning: Space-1-3 or Space-1-2-3 

Go to end: Space-4-6 or Space-4-5-6 

Move to the next page: Space-3-4-5 

Move to the previous page: Space-1-2-6 

Go to page: Enter-g (dots 1-2-4-5) 

Select previous text unit: Dot 1 

Select next text unit: Dot 4 

Move to previous text unit: Dot 2 

Move to next text unit: Dot 5 

Select previous movement unit: Dots 2-3 

Select next movement unit: Dots 5-6 

Move to the previous unit: Dot 3  

Move to the next unit: Dot 6  

Move to the next heading: Space-5  

Move to the previous heading: Space-2  

Move to the last heading: Space-4-6 

Move to the first heading: Space-1-3 

Check the current-reading level and heading: Enter-w (dots 2-4-5-6) 

Find heading: Space-f (dots 1-2-4) 

Headings list: Enter-h (dots 1-2-5) 

Find again: Enter-f (dots 1-2-4) 

Set mark at current position: Enter-m (dots 1-3-4) 

Move to the next mark: Space-dot 6 

Move to the previous mark: Space-dot 3 



 

 

Delete mark: Space-d (dots 1-4-5) 

Create memo: Backspace-m (dots-1-3-4) 

Read memo: Backspace-r (dots-1-2-3-5) 

Read previous memo: Backspace-p (dots-1-2-3-4) 

Read Next Memo: Backspace-n (dots-1-3-4-5) 

Delete Memo: Backspace-d (dots-1-4-5) 

Exit and erase position without prompt: Enter-z (dots-1-3-5-6) 

Exit and erase marks without prompt: Backspace-z (dots-1-3-5-6) 

 

Applications 

1) Calculator  

 

View calculation result (=): Enter 

Type new calculation: Enter 

Plus: dots 3-4-6 

Minus: dots 3-6 

Multiply by: dots 1-6 

Divided by: dots 3-4 

Percent: dots 1-4-6 

Power: dots 4-5-7 

Decimal point: dots 4-6 

Left parenthesis: dots 1-2-3-5-6 

Right parenthesis: dots 2-3-4-5-6 

Clear all: Ctrl-A 

Save to file: Ctrl-S 

Copy calculation line: Ctrl-C 

Paste: Ctrl-V 

Copy Result: Ctrl-R 

Review previous calculation and result: Up arrow 

 

2) Stop Watch 

 



 

 

Start/Stop: Enter 

Pause: Space 

Reset: Backspace 

 

3) Countdown Timer 

 

Start/Stop: Enter 

Pause: Space 

Reset: Backspace 

Close: ESC key 

 

Commands for Status, Troubleshooting, and maintenance 

Braille and Key Test Mode: Space-Enter-Backspace-T. (Global key to activate, to test pins and identify keys) 

ActiveSync Mode (Focus information): Enter-Backspace-Space-Dots-1-2-3-4-5-6. (for developers, but if you 

receive the message “Cannot Open Port” when trying to connect, use this key to turn it off.) 

One Handed-Mode: Backspace-1-2-3 

Upgrade Mode (In information): U. (will check for upgrade and initiate. You can also just power unit 

completely off and back on.) 

Initialize all Settings and pairings (Focus information): Enter-Space-Backspace-Dots-1-2-4. (resets pairings, 

options, and refreshes Bluetooth driver.) 

Reboot (Focus main menu): Left Alt + Right Application + Dots-1-2-3-4-5-6-7-8. (Soft Reset) 

Check QWERTY driver version: Enter-Space-Backspace-1-2-3-6. 

Set Bluetooth Chip profile (Focus Connectivity): Enter-Space-Backspace-Dots-1-2-3-4-5-6. (To update 

Bluetooth chip settings, try if Bluetooth connection cannot be established.) 

Braille Test Mode (In information): Enter-Backspace-Space-X. (To test pin functions and get key information. 

Press same to exit.) 

Exam Mode(Focus main menu): MODE+L. (To lock in Terminal for Screen reader for taking exams. Will be 

requested to create a password, which must also be entered on exit.) 

Typing Mode(Only in Notepad): Alt-K. (To be used if user is accidentally activating menus and commands due 

to typing too fast.) 



 

 

Mass Storage Mode(Focus main menu): MODE+Space. (To see SD card as drive on PC.) 

Change Bluetooth Name*only in firmware prior to 12/2019: (Focus Connectivity), Enter-Backspace-Space-

Dots-1-3-4-5. (to be used if user encounters situation of only displaying 32 characters.) 

  

 


